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S E I M S  O N E - S T O P  V O T I N G  A P P L I C A T I O N   
( S O S A )  G U I D E   

DISCLAIMER 

The data contained in the screenshots of this document is test data and is for demonstration purposes only. 

 

The SEIMS One-Stop voting application (SOSA) is used for early voting at off-site locations. There are 2 
different modes that can be used: 

COUNTY:  In the County BOE office  
This mode was formerly known as Connected Only. 
This mode is used if there is an available, stable network connection to the county database server.  
All activity is performed real-time, and other SEIMS users will be able to see registration changes and 
absentee voting appear as it happens.  This is the mode commonly used if the application is installed 
on a county workstation with other SEIMS applications already installed.  

 
LOCAL:   
This mode was formerly known as Hybrid and Disconnected. 

• Off site (or non-SEIMS office machine) with a reliable connection to the SEIMS Server 
This mode is used if there is an available, mostly reliable network connection to the county database 
server.  It allows the user to look up registered voters for the county for a specific election on a local 
machine; however, any activity performed on the machine is transferred back to the county database 
server on a periodic basis automatically.  This allows the user to continue working should a network 
connection loss occur.  This is the recommended mode in which to operate. 

• Off site with no connectivity to the SEIMS Server 
This mode is used if there is no available network connection from the satellite voting location to the 
county database server.  It allows the user to look up registered voters for the county for a specific 
election on a local machine.  The user may also perform registration changes and cast votes for 
registered voters that are allowed to vote in the given election.  The activity is stored locally and must 
be transferred manually on a portable media device through a data file export/import methodology. 
 

This document will describe how to use SOSA. It will also give step-by-step instructions on how to do basic 
tasks. Generally, the process of voting is the same in all both modes. The only difference is when the data is 
transferred back and forth between the live database and the One-Stop machines. 
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CHAPTER 1: GETTING STARTED 

SECTION 1:  OVERVIEW 

The SEIMS One-Stop Voting application (SOSA) is used to process in-person early voting at one-stop sites 
throughout a specific county.  This chapter discusses how to access SOSA and prepare for use.  Topics 
discussed are how to login to the application, how to set the voting site, how to set and change system options 
and how to perform validation.  The tasks in this section are usually completed by the SOSA Administrator in 
office before sending the machines out to the one-stop sites. 

SECTION 2:  LOG-IN PROCEDURE 

Use the following steps to start-up and log into the One-Stop Voting application. 

1. From the computer desktop, double-click the One-Stop Voting icon and the One-Stop Voting 
authentication window will appear. 

2. Each user must enter their unique username and password for 
the installed Environment; either ‘Production’ or ‘Training’.  
Then use the ‘Location’ drop-down arrow to select ‘COUNTY’ or 
‘LOCAL’ depending on the county preference.  Click the ‘Login’ 
button to login to SOSA, or click the ‘Cancel’ button to cancel the 
login. Click ‘Login’. Voting Information popup appears.  If the 
site and location match, click the ‘OK’ button.   

 

If the SOSA Voting Information popup below left appears with 
the information shown in red, refer to the SOSA Administrator 
Guide to select an Election Site and Validate the machine.  
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3. The main screen appears.  

 

 

 

The SOSA Voting application’s title bar displays the following information, as shown in the image 
below:  

 

• Application Name and software version: SOSA Voting (v.2.4.40) 
• Connection Type: Local  
• Database name: one_stop 
• User Login Name: eburton 
• Election Date and Name: 07/11/2017 Municipal 
• Machine Number: 100 
• Voting Site: WMB 
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SECTION 3:  SOSA OPTIONS 

SOSA has several different settings that can be used to optimize the application according to the county needs.  
Most of these options should have been set by the administrator, but those settings may be changed if the 
situation warrants it.  To 
open the options screen, 
click on the Tools  Options 
menu item in SOSA.  The 
screen to the right will 
display.  

 

 

 

 

 

 

 

The SOSA options are described below. 

ONE-STOP SITE PROPERTIES 

Defaults 

Election Site Name Indicates the one-stop site to which this machine is assigned. 

Default Database Sets the default database connection: COUNTY or LOCAL 

Allow Curbside Voting Controls whether or not curbside voting is allowed in the application. 
Allow Provisional 

Voting 
Enables Provisional voting functionality in the application.  

Default Voting Method Sets the default voting method, which can be ‘In-Person’ or ‘Curbside’. 
Allow Registration 

Changes 
Controls whether or not registration changes are allowed in the application. 

Create BOD file with 
vote cast 

Allows the creation of a BOD (Ballot on Demand) data file when the vote button is selected. 

Printing 

Printer Type Sets the type of paper to print documents within SOSA.  Forms can be printed on a standard printer 
(Application 8.5x11), a Smart Label Printer (Label 54mm x 101mm) or nothing at all (None).  If 
standard paper is not selected, the SOSA reports will not be available. 

# of Application copies Set the number of copies of the absentee application to print.  One to five copies of the Absentee 
Application can be printed.  One is the default. 

Current Printer Only displays the default printer for the machine.  To change this, the user must change the default 
printer in Windows. 
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ONE-STOP SITE PROPERTIES 

Test Print The function allows the user to send a test page to the default printer to make sure it is working 
correctly. 

Enable Print Preview This option is only available when running SOSA against a Training database (instead of 
Production).  This will allow all documents that normally go straight to the printer, to preview on-
screen.  A print button is available on the preview window if it is decided to actually print the 
document.  This will help save paper during training sessions. 

Import 

Default File Location Allows the user to change the default location SOSA uses to find import (Transfer Data to/from 
BOE) files.  Click the Browse button to select a different file location. 

File Name Prefix Only displays the import file name prefix.  All import files should start with the characters 
OSVDB. 

Export 

Default File Location Allows the user to change the default location SOSA uses to place export (Transfer Data to/from 
BOE) files. Click the Browse button to select a different file location.  

File Name Prefix Only displays the export file name prefix.  All export files will begin with the characters OSV. 

Data Transfer Time Intervals (for Electronic transfers) 

Transfer Rate Sets the time interval in which SOSA Electronic transfers occur. 

Test County Connection LOCAL Mode only: Tests whether or not SOSA can connect to the county server.  
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CHAPTER 2: SEARCHING 

SECTION 1:  OVERVIEW 

In SOSA, searching is the critical function needed to find the voter who wishes to participate in early voting.  It 
is used to look registered voters up to be able to process votes, registration changes, or even look up their 
current information. 

SECTION 2: SOSA MAIN SCREEN 

Below is the main SOSA Voting screen.  The top section of the screen displays all of the criteria fields available 
for searching.  The center of the screen displays the search results in a grid, and the bottom section displays 
registration and/or vote information for a selected voter.  All of the buttons available for specific One-Stop 
tasks appear along the top of the screen.  An explanation of the available functions can be found in the table 
below. 
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SOSA SCREEN FUNCTIONALITY 

# Button Name Description 

1 Search Initiates the search of the county database for potential voters based on the criteria entered and 
displays the results in the Potential Voters grid.  Current search return limit is 500 records. 

 2 Clear Clears all fields of data 

 3 More Criteria Displays address fields for searching 

 4 Show Removed 
Voters 

Allows the user to toggle whether or not Removed/Denied voters appear in the search results 

5 Issue Initiates the vote process for the selected voter from the Potential Voters grid (see Chapter 3 
Section 2). Has drop-down for In-Person and Curbside if SOSA Option is set to “Allow Curbside 
Voting”. 

6 Cancel Vote Opens the Cancel Vote screen to cancel a vote performed on the same machine in error. 

7 Note Opens the Note screen to begin adding a note to the voter’s absentee vote information. 

8 Reprint Allows the user to reprint the voter application to the designated printer. 

9 New Voter Reg Opens the New Registration screen to register and vote a Same Day (IPR) registrant  

10 Update Voter Reg Opens the Edit Registration screen to begin editing voter information that has been provided with 
a voter application. 

11 View Voter Reg Opens the Voter Registration screen in read-only mode so the user can review the voter 
information in detail. 

12 New Voter Prov Allows a new provisional voter to be added (non-existing registrant).  

13 Existing Voter Prov Allows adding a provisional vote to an existing registered voter.   

14 View Prov Allows viewing the provisional vote entered on this machine. 

15 Reprint Allows the reprinting of Provisional forms to the designated printer. 

16 Print Referral Allows the printing of a blank Help Referral Form or a pre-populated form for a selected voter. 

 

SECTION 3:  VOTER SEARCH 

In the Search Criteria section of the SOSA main screen, there are criteria fields that may be used to find a 
specific voter.  The default search fields are Last Name, First Name, Middle Name and DOB (MM/DD/YYYY). 
To display address search fields of House #, Dir, Street Name, Type, Suffix, Unit, City, State, and Zip Code, 
simply click the ‘More Criteria’ checkbox on the Home ribbon. The user may use any combination of the 
search criteria fields.  Using a combination of search options will return more defined results in the Potential 
Voters Grid.  A wild card (%) may be used in the name fields to allow for find a variety of potential matches, 
especially if the spelling of the name is not known.  Any results found will be displayed within the Potential 
Voters grid found below the Search Criteria section. 

The below example shows the steps to a simple name search:  
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1. Enter the voter’s last name in the ‘Last Name’ field, e.g. “SMITH”.  If the user is unsure of the 
spelling of the voter’s last name (SMITH vs. SMYTH), the wildcard symbol (%) can be used to 
ensure all spellings of the name are located (e.g. “SM%TH”).  

2. Enter the voter’s first name in the ‘First Name’ field, e.g. “DAISY”.  

3. Click ‘Search’ or press ‘Enter’. Alternatively, click the Barcode Scan icon to the right of the DOB 
field to scan an NCDL barcode from a voter’s driver’s license which will prevent the need for 
manual data entry in the search fields. 

 

A search on just a voter’s last name can be used.  
However, to speed up the search and reduce the 
number of voters located, it is best to use both the 
first and last name of the voter.  If more than 500 
results are going to be returned, a message displays 
to narrow the search.  Click ‘OK’ to clear the message 
and begin the search again. 

The results will populate in the Potential Voters section of the main screen, as shown below. 

 

If the voter’s name cannot be found, try the following: 

• Verify the spelling of the name. 

• Verify there is no name change. 

• Search using only a portion of the voter’s last name and first name, such as the first few letters 
and add the wildcard symbol (%) at the end. 

Example: ‘Last Name’: “SM%” ‘First Name’: “D%”, this will find all voters with last names 
beginning with “SM”, and first names beginning with “D”. 

• Search using other criteria fields instead, such as ‘Street Name’ or ‘DOB (MM/DD/YYYY)’. The 
‘More Criteria’ and ‘Show Removed Voters’ check boxes on the Home tab will give you more 
search options.  

If the voter cannot be found, follow the process defined by the County Board of Elections.  The voter 
may need to vote a Provisional ballot. 
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SECTION 4: VOTER INFORMATION OVERVIEW 

Upon performing a successful search that returns a list of voters, the SOSA main screen will display that list of 
voters within the Potential Voters grid, along with any provisional records entered on the machine; a sample 
of which is shown below.  Each voter record will display the information as defined in the grid below. 

 

 

POTENTIAL VOTERS GRID COLUMN DEFINITIONS 

# Column Name Description 

1 Name The full name of the registered or provisional voter presented as last name first. 

2 Address The residential address of the registered or provisional voter. 

3 Mail Addr Indicates with an X that the registrant or provisional voter has a mailing address. 

4 Ballot Style The ballot style of the registered or provisional voter. 

5 Party (Voted Party) Displays the registrant or provisional voter’s registered party and party voted 

6 Gender The gender of the registered or provisional voter. 

7 Race The race of the registered or provisional voter. 

8 DOB The date of birth of the registered or provisional voter. 

Note: Do NOT give a voter’s date of birth to another person for any reason, as by law, this 
information is confidential!  

 
When a voter’s record is selected, additional information for the selected voter will appear at the bottom of 
the window on the Voter tab.  
 

VOTER INFORMATION PANEL 

The Voter Information Panel displays information about the selected voter’s registration, separated into the 
Voter tab and the Changes tab. The voter’s registration information appears on the left side of the Voter tab 
and the voter’s vote status appears on the right side of the Voter tab. If the selected voter has previous vote 
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activity for the current election, information will display; if they have no activity, the area will be empty.  If 
any registration changes have been made to the selected registrant, they will appear on the Changes tab. 

 

Descriptions of the registered voter’s information and when it is displayed, as well as a magnified version of 
the panel, is presented below. 

 

Magnified Voter Information Panel 

 

 INFORMATION THAT APPEARS IN THE VOTER INFORMATION PANEL 

Tab Type Condition Value 

Voter 
(left) 

VRN Appears when the voter is a registered voter.  New 
registrants will have a blank value. 

Displays the voter’s voter registration number 
in the county. 

Voter 
(left) 

Name  Always displays. Displays voters’ name as: 
Last Name, First Name, Middle Name 

Voter 
(left) 

Address  Always displays. Mailing address will display if 
Mail Addr column contains an X. 

Displays voters’ residential address. 

Voter 
(left) 

PCT/VTD  Always displays. Displays the Precinct and VTD associated 
with the voters’ registered residential address. 

Voter 
(left) 

Status Always displays. Displays the current status of the registered 
voter: 
Active, Inactive, Removed, Denied, 
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Temporary  

Voter 
(right) 

No Ballot Red exclamation triangle icon displays indicating 
the selected registrant has no ballot for the 
election. 

No Ballot Style  

Voter 
(right) 

Can Vote Green checkmark icon displays indicating the 
selected registrant is eligible to vote. Green check mark  

Voter 
(right) 

Voted Displays red exclamation triangle icon when a 
voter presents themselves to vote when they have 
previously voted in the current election--if the 
“Prevent users from votes/updates once vote is 
cast” option is left unchecked when the wizard is 
run.  

Voted  

 

Voter 
(right) 

Voted Displays black and red “no” icon when a voter 
presents themselves to vote when they have 
previously voted—if the “Prevent users from 
votes/updates once vote is cast” option is checked 
when the wizard is run. 

Voted  

Voter 
(right) 

Cannot 
Vote 

Displays when a voter presents themselves to vote 
and they are in a Removed or Denied status. Black 
and red “no” icon displays. 

Removed/Denied Voter  

Voter 
(right) 

Return Envelope icon displays indicating that a By-mail 
absentee ballot has been returned to the One-Stop 
site. 

Return Processed  

Voter 
(right) 

ID 
Validation 

ID icon displays when the voter is flagged as 
needing to provide HAVA ID. 

Indicates that the voter must provide Proof of 

ID before voting.  

Voter 
(right) 

Inactive 
Voter 

Address book and red exclamation triangle icons 
display when a voter presents themselves to vote 
after their status changed to Inactive. 

Indicates that the voter’s registration 
information must be verified before voting 

may occur.  

Voter 
(right) 

Note Note icon displays if there is a note on the selected 
voters record. 

Note  

Voter 
(right) 

Provisional 
Voter 

Provisional icon displays when a record was 
logged as a provisional voter. 

Indicates that the potential voter voted as a 

Provisional  

Voter 
(right) 

Election 
Date 

Populates with the current election information 
after the Vote button is clicked. 

Displays the election date in mm/dd/yyyy 
format. 

Voter 
(right) 

Voted Date Populates with the date that the voter presented 
themselves to vote after the Vote button is clicked. 

Displays the date voted in mm/dd/yyyy 
format. 

Voter Ballot Style Populates with the Ballot Style assigned to the Displays the ballot style the voter should 
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(right) voter after the Vote button is clicked. have received. 

Voter 
(right) 

PCT/VTD Populates with the precinct and VTD information 
linked to the address after the Vote button is 
clicked. 

Displays the precinct and VTD related to the 
ballot cast. 

Voter 
(right) 

Ballot ID Populates with the Ballot ID associated with the 
voters’ record after the Vote button is clicked. 

Displays the ballot id, which is made up of 
machine abbreviation and a unique ballot 
number for that machine (e.g. 101-56). 

Voter 
(right) 

Appl. Num Populates with the Application No. after the Vote 
button is clicked. 

Displays the application number of the one-
stop vote, which is made up of request type 
(this will always be “OS”), voting place, 
machine number, and a sequence number 
(e.g. OS-OFF-101-98). 

Voter 
(right) 

Action Populates when a voter has successfully cast a 
ballot. 

VOTED 

Changes Name 
Change 

Displays if a Name Change was made to the 
selected registrant. 

Displays Name Change From/To when a 
name change is made 

Changes Address 
Change 

Displays if an Address Change was made to the 
selected registrant. 

Displays Address Change From/To when an 
address change is made 

Changes PCT/VTD 
Change 

Displays if a Precinct/VTD Change was made to 
the selected registrant. 

Displays PCT/VTD Change From/To if a 
precinct change is made 
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CHAPTER 3: ONE-STOP AND PROVISIONAL VOTING PROCESS 

SECTION 1:  OVERVIEW 

The primary purpose of SOSA is to incorporate all the rules and manage the one-stop voting process within a 
given county.  This chapter will detail all phases of the voting process, including how to vote a registrant, how 
to cancel a vote, how to use the re-vote function (if allowed by the CBE), how to add a note to a voter, and how 
to reprint an application. SOSA also allows Provisional Voter information to be entered, removing the need for 
the manual provisional process at One-Stop sites.  

One-Stop voting exists to allow registered voters to vote in-person at specific designated voting places during 
a short time period between the registration cutoff for an election and the election itself.  The major 
distinguishing factor between one-stop voting and Election Day voting is that one-stop ballots are retrievable. 

SECTION 2:  HOW TO VOTE (ONE-STOP) 

In simplest terms, the One- Stop voting process consists of three steps: searching for the registered voter, 
selecting the correct voter, and clicking the Issue button.  There are a lot of small variances that may be 
encountered along the way such as id being required, addresses needing to be verified or even ballot party 
needing to be chosen for primary elections.  These will be addressed during the following listed steps of the 
process or in other sections of this guide as noted. 

1. Enter appropriate search criteria into the Search Criteria fields.  This will typically be a name search 
using the last name and first name (or first few characters of the first name with a wildcard). To 
search address fields, click the ‘More Criteria’ check box on the Home ribbon. Alternatively, the 
barcode search icon (to the right of the DOB field) can be clicked to scan a NC Driver’s License barcode 
which will auto-populate most of the voter’s information.  

2. Click the ‘Search’ button. 

a. If the voter is located, proceed to step 3. 

b. If the voter is not located: 

• Check spelling of name. 

• Use wildcard option (%) to search for name. 

• Verify that the voter has not changed their name since their last registration update. 

i. If there is a Name Change, proceed with a voter update using the ‘Update Voter 
Reg’ button accessible from the Home ribbon.  See Chapter 4, Section 2 for details 
on updating registrations.  

ii. If the voter is still not located, refer to county procedure to continue.  Voter may 
need to vote a Provisional ballot. 

3. Select a voter from the Potential Voters grid. 

If the VoterView System Format Option ‘EPB: AUTOSELECT SEARCH RESULT’ is set to ‘Y”, the first 
result in the grid will be selected automatically.  

 

Warning:  There may be several voters with the exact name.  Always verify the correct voter is 
selected by having the voter verify their: 
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• Full Name 

• Residential Address 

Upon selection of a voter within the grid, the following actions are performed: buttons may be enabled 
or disabled based on the allowed functionality and the voter information section is populated (see 
Chapter 2, Section 4). 

4. Check the voter’s vote status on the right side of the Voter Information Panel. 

 
Magnified Voter Information Panel 

a. If there is no data in the Voter Information Panel, proceed to Step 5. 

b. If there is data in the Voter Information Panel, this window indicates the voter may have voted by 
paper Absentee ballot or at another Early Voting site.  

i. If the voter is showing as VOTED but claims they did not vote already, proceed with the 
Cancel Vote or Re-Vote process set forth by the county board of elections.  Cancel vote is 
discussed in Section 3 and Re-Vote is discussed in Section 4 of this Chapter.  

ii. If the voter is showing VOTED and did actually vote already, this voter should not be 
allowed to vote again.  

5. Check the voter’s registration status on the left side of the Voter Information Panel. 

 
Magnified Voter Information Panel 

a. If the status is ACTIVE or TEMPORARY, verify the registrant has a valid Ballot Style (e.g. G001) and 
proceed to Step 6. If the voter has NO BALLOT as the Ballot choice, the voter has no contest for the 
selected election and should not be allowed to vote.  

b. If the status is REMOVED or DENIED, they are not registered to vote in the election. They must 
vote provisionally. 

c. If the voter is INACTIVE, their registration must be updated using the ‘Update Voter Reg’ button.  
This will update their status to ACTIVE and allow them to vote. Please review Chapter 4, Section 2 
for instructions on making registration updates.  
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6. Verify the voter’s name and address information. 

a. If the registration information is accurate and the voter has a ballot option, proceed to Step 7. 

b. If any voter information needs to be updated click the ‘Update Voter Reg’ button and make the 
changes. Do not continue with the remaining steps in this section. See Chapter 4, Section 2 for 
instructions on making registration updates. 

7. Click the ‘Issue’ button to process a vote for the selected registrant. 

NOTE: Clicking the ‘Issue’ button drop-down will give the option to Issue In-Person or Issue Curbside (if 
‘Allow Curbside Voting’ is checked in the options).  Clicking ‘Issue’ without using the drop-down will use 
the ‘Default Voting Method’ that was set in the options. 

a.  If the voter is required to show HAVA ID before voting, the Proof of ID Required pop-up, as shown 
to the right, will appear.  The type of ID the voter provides must be selected; the different types 
are listed in the table below.  Once a type has been selected, click the ‘Save’ button.  Select the 
‘Cancel’ button if the screen has displayed unintentionally. 

 

 

 

 

 

 

 

 

 

 

 

 

• If the voter does not provide the required ID, click ‘Cancel’ and proceed with the county 
defined process. 
 

b. If the voter’s party is registered Unaffiliated and the 
election is a primary, the Party Required pop-up will 
appear, as shown to the right.  Select the Party of the 
ballot indicated by the voter.  Click the ‘Save’ button to 
continue with the ballot issue process. 

  

ID DOCUMENTS 

• Bank Statement  
• Government Check  

• NC Drivers License  
• NC Non-Operators ID  
• Other Government Document  
• Other Photo ID  
  • Paycheck 
• Tribal Enrollment Card 
• U.S. Passport 
• US Military ID  
• Utility Bill 
• Veterans ID 
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8. The Issue Vote screen will display with all fields grayed out, as shown below and the One-Stop 
Application or label (depending on the print settings) will print. 

 
 

a. If everything is correct, click ‘Vote’ to complete the ballot issue process. DO NOT CLICK 
CANCEL VOTE!  
 

• If the voter needs to update their name or address before the vote is processed, click ‘Update 
Voter Reg’ to enable the Name and Address fields. Make any necessary changes and click 
‘Review’. The One-Stop application form/label will print for the voter to verify the change and 
sign. Click ‘Vote’ to complete the ballot issue process.  
 

• If the voter needs to vote Provisionally, the ‘Vote Provisional’ button will exit the Review 
process and launch the Provisional Data Entry process. See Chapter 3, Section 7 for details on 
the provisional voting process in SOSA.  
 

• If the voter has an issue that requires sending him to the Help Desk, click the ‘Print Referral’ 
button to print a Help Referral Form which the voter will take with them to the Help Desk. The 
‘Absentee History’ button will display any Absentee information for the current election.   
 

• To cancel the Issue process on the selected voter, click the ‘Cancel Vote’ button. 
 

9. If the SOSA option “Create BOD file with vote cast” is enabled, an XML file will be created in 
C:\tmp\BOD with the vote information.  

If the incorrect voter was voted, search for the voter again and then proceed with the ‘Cancel Vote’ 
process (or the county defined process).  See Section 3 for instructions on cancelling a vote. 
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SECTION 3: CANCELLING A VOTE (ONE-STOP) 

The cancel vote functionality is available when a user votes for a registered voter incorrectly.  Reasons for the 
incorrect vote include, but are not limited to, selecting the wrong registered voter, choosing the wrong ballot 
party for a primary, forgetting to update the residential address. 

• This process MUST be completed at the same computer station where the voter was initially 
processed. 
• The Cancel Vote permission is required for the One-Stop Application to perform this task. 
• The “Allow user to cancel Votes” option must be selected when the wizard is performed. 
• Provisional Votes cannot be cancelled.  

To cancel a vote for a registrant, perform the following steps: 

1. Using the Search function, find the voter that has already voted. 

2. Select the voter’s record in the Potential Voters grid to highlight it. 

3. Click the ‘Cancel Vote’ button on the Home ribbon. 

4. The Cancel Vote window will appear, as shown to the right.  Use 
the ‘Reason’ drop-down arrow to select the appropriate reason 
for canceling the vote; the reasons are described below.  Enter a 
Comment in the ‘Comments’ field as it is required.  Click the 
‘Cancel Vote’ button once complete. 

Available Reasons for Cancelling a Vote 

Code Reason Description 

CN CANCELLED Use when one-stop worker needs to 
cancel a “VOTE”. 

NV NOT VOTED Use when one-stop application was 
issued, but voter chose not to vote at that 
time. 

WV WRONG 
VOTER 

Use if it is determined that the one-stop 
ballot was issued to a person other than 
the voter.  

Note: Any record with this reason will 
NOT receive a contact. 
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SECTION 4: RE-ISSUING (ONE-STOP) 

Re-Issue may not be allowed in SOSA if the county prohibits it.  This function is set by the SOSA 
administrator when running the Wizard.  It cannot be changed in the SOSA Voting application.  

The Re-Issue process will change the ballot return status in VoterView Absentee to CF (Conflict) for 
both votes.  The CBE office would then need to resolve this conflict before voter history can be 
applied.  

To use the Re-Issue function, perform the following steps: 

1. Using the Search function, find the voter that has already voted. 

2. Select the voter’s record in the Potential Voters grid to 
highlight it. 

3. Click the ‘Issue’ button.  The Vote window will appear, as 
shown to the right.  Use the ‘Reason’ drop-down arrow to 
select the appropriate reason for the re-issue; the reasons are 
described below.  Enter a Comment in the ‘Comments’ field as 
it is required.  Click the ‘Vote’ button once complete.  

4. The Issue Vote screen will display. If any changes need to be 
made to the voter’s name or address, click ‘Update Voter Reg’ 
to make the changes and review them. Otherwise, click ‘Vote’ to 
complete the re-issue process.  See Chapter 3, Section 2 for 
more information on how to process a vote. 

Available Reasons for Cancelling a Vote 

Code Reason Description 

CN CANCELLED Use when one-stop worker needs to 
cancel a “VOTE”. 

NV NOT VOTED Use when one-stop application was 
issued, but voter chose not to vote at that 
time. 

WV WRONG 
VOTER 

Use if it is determined that the one-stop 
ballot was issued to a person other than 
the voter.  

Note: Any record with this reason will 
NOT receive a contact. 
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SECTION 5: ADDING A NOTE TO A VOTED RECORD (ONE-STOP) 

The ‘Note’ button is available for use if there is a need to add a note to a one-stop vote record.  The ‘Note‘ 
button is only enabled when a registrant has voted on the SOSA machine. Notes are disabled for Provisional 
votes.  

To add a note to a voted registrant, perform the following steps: 

1. Using the Search function, find the voter that has already voted. 

2. Select the voter’s record in the Potential Voters grid to 
highlight it. 

3. Click the ‘Note’ button on the Home ribbon. 

The Note window will appear, as shown to the right.  
Type the note information into the Additional Note field.  
When finished, click the ‘Add Note’ button. 

NOTE: If the record already has a note attached, the 
‘Note’ button will be green in color and the note will 
appear in the Current Note section of the Note window.  

4. To review the note that was just added, search for the 
voter again and click the green ‘Note’ button. 
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SECTION 6: REPRINTING AN ONE-STOP APPLICATION  

If a problem occurs during the voting that prevents the One-Stop Application/Label from printing, the 
application can be reprinted using the ‘Reprint’ button on the Home ribbon.  There is also a way to reprint the 
Name/Address change form/label that prints when performing an Update Voter change. 

To reprint the One-Stop application/label: 

1. Using the Search function, find the voter that has already voted. 

2. Select the voter’s record in the Potential Voters grid to highlight it. 

3. Click the ‘Reprint’ button. 

 

SECTION 7: PRINTING A HELP REFERRAL FORM 

A Help Referral Form is available if the check-in (registration table) official determines there is a need to refer 
the voter to the Help Desk. To print the form, follow the steps below: 

1. Click the ‘Print Referral’ button and choose ‘Print Blank’ to print a blank form or click ‘Print Selected 
Record’ to print the form for the selected record. 

 

On the referral form, the appropriate box will be blackened at the top to indicate One-Stop or Election 
Day. The example on the next page is a form printed from SOSA.  



- 25 -  SOSA User Guide 

 

  



- 26 -  SOSA User Guide 

SECTION 8:  HOW TO VOTE (PROVISIONAL) 

The Provisional voting process consists of four steps: searching for an existing or adding a new provisional 
voter, entering registration information, entering provisional information, and Vote.  ‘Existing Voter Prov’ 
allows you to create a Provisional record for an existing registrant. ‘New Voter Prov’ allows you to create a 
Provisional record for an unregistered voter.  There are a lot of small variances that may be encountered 
along the way such as id being required, addresses needing to be verified, or even ballot party needing to be 
chosen for primary elections.  These will be addressed during the following listed steps of the process or in 
other sections of this guide as noted.   

1. Enter appropriate search criteria into the Search Criteria fields.  This will typically be a name search 
using the last name and first name (or first few characters of the first name with a wildcard). To 
search address fields, click the ‘More Criteria’ check box on the Home ribbon. Alternatively, the 
barcode icon (to the right of the DOB field) can be clicked to scan a NC Driver’s License barcode which 
will auto-populate most of the voter’s information.  

2. Click the ‘Search’ button. 

3. If the voter is located, select their record from the results grid and click ‘Existing Voter Prov’ from the 
Provisional Voting section of the ribbon. If the voter is not located, click ‘New Voter Prov’. 

 
4. The Provisional Data 

Entry screen 
(registration 
information) will 
display. If ‘Existing 
Voter Prov’ was clicked, 
any data from the 
current voter’s record 
will be pre-populated 
in the appropriate 
fields, as shown to the 
right.   
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If ‘New Voter Prov’ was clicked the screen will be blank (as shown in the image below). 

 
5. Fill in appropriate registration data or scan an NCDL barcode to automatically populate voter data. 

Fields with names in red text are required and must be populated to move to the next step. When all 
data has been entered, click ‘Next’.  

If the voter does not want to vote provisionally, click the ‘Acknw Only’ button to print an 
Acknowledgment Notice which informs the voter of their options to vote and must be signed by 
the voter. Clicking ‘Acknw Only’ prints the form and cancels the Provisional vote process.  

This data will be transferred to One Stop System Manager with the rest of the SOSA 
vote/update/provisional data and can be found under ToolsAcknowledgment of Voting Options. 

To check the status of a NC Driver’s License, click the small barcode icon to the right of the US 
Citizen checkbox and scan the NCDL with a 2D scanner to determine if the ID is expired or not 
expired. If a match is found, it will also populate the voter data on the screen. See Section 10 for 
more information on scanning NCDLs.  
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6. The Proof of ID Required pop-up, as shown below, will appear.  The type of ID the voter provides must 
be selected; the different types are listed in the table below.  Once a type has been selected, click the 
‘Select’ button.  If the Provisional voter does not provide ID, click the ‘No ID’ button. Select the ‘Cancel’ 
button if the screen has displayed unintentionally. 

 

 

 

 

 

 

 

 

 

• If the voter does not provide the required ID, click ‘No ID’ and proceed with the provisional 
process. 

 

7. Based on the voter’s address and party information entered on the Provisional Data Entry screen, a 
default ‘Party Voted’ and ‘Ballot Style 
Issued’ will be set.  If the voter’s 
registered party is Unaffiliated and the 
election is a primary, the message 
shown to the right may display (if there 
are no UNA contests).  Click OK and 
select the appropriate ‘Party Voted’ 
from the drop-down on the Provisional 
Information screen. Select the appropriate ‘Ballot Style Issued’ from the drop-down (see example on 
next page). The ‘Ballot Style Issued’ field will not be populated if there is not a matching ballot style 
for the address (likely due to a Geocode issue).    
 

8. The Provisional Data Entry (provisional information) screen will display.  

ID DOCUMENTS 
• Bank Statement  
• Government Check  
• NC Drivers License  
• NC Non-Operators ID  
• Other Government Document  
• Other Photo ID  
  • Paycheck 
• Tribal Enrollment Card 
• U.S. Passport 
• US Military ID  
• Utility Bill 
• Veterans ID 
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Select a Provisional Voting Reason from the drop-down and the Ballot Style Issued (if not already 
populated).  

 
If the provisional vote was cast curbside, check the ‘Curbside’ box.  

If the voter does not want to vote provisionally, click the ‘Acknw Only’ button to print an 
Acknowledgment Notice which informs the voter of their options to vote and must be signed by the 
voter. Clicking “Acknw Only’ prints the form and cancels the Provisional vote process.  

Click ‘Review’ once all required fields are populated. The Provisional Voting Application form/label 
will print to the default printer. If ‘Reasonable Impediment’ was set to ‘Yes’, the Reasonable 
Impediment Declaration form will also print. 
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9. The Provisional Data Entry (review) screen will display as shown below. 

 
 

a. To cancel the Provisional process on the selected voter, click the ‘Cancel Vote’ button.  
b. If the voter does not want to vote provisionally, click the ‘Acknw Only’ button to print an 

Acknowledgment Notice which informs the voter of their options to vote and must be signed 
by the voter. Clicking “Acknw Only’ prints the form and cancels the Provisional vote process.  

Once ‘Vote’ has been clicked, a Provisional vote cannot be cancelled afterward. The ‘Note‘ 
function is also disabled for Provisional records. 

 
c. If everything is correct, click ‘Vote’ to complete the Provisional process. The Provisional Voter 

Instruction sheet or label (depending on the print settings) will print. 
 

10. If the SOSA option “Create BOD file with vote cast” is enabled, an XML file will be created in 
C:\tmp\BOD with the vote information.  
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SECTION 9: REPRINTING A PROVISIONAL FORM 

If a problem occurs during the voting that prevents the Provisional Forms/Labels from printing, the 
application can be reprinted using the ‘Reprint’ button in the Provisional Voting section of the Home ribbon.   

To reprint the Provisional form/label: 

1. Using the Search function, find the voter that has already voted. 

2. Select the voter’s record in the Potential Voters grid to highlight it. 

3. Click the arrow under the ‘Reprint’ button in the Provisional Voting section of the ribbon. Choose 
‘Reprint Provisional Form’ or ‘Reprint Instruction Sheet’.  

 

 

SECTION 10: 2D BARCODE SCANNING FOR DRIVER’S LICENSE VALIDATION AND VOTER 
DATA POPULATION 

SOSA now offers the ability to scan a North Carolina driver’s license to verify that the license is valid and to 
automatically populate voter data on the Search or Data Entry screens.  

2D Barcode scanning can be accessed from the following screens by clicking 
the small barcode icon that appears near the US Citizen check box: Update 
Voter Reg, Issue Vote, New Voter Prov and Existing Voter Prov.  

There is also a Barcode Search icon on the main screen (to the right of the 
DOB field) to populate search criteria (see page 33).  

1. To verify a license click the Barcode 
icon. The pop-up to the right displays. 

2. Click in the NCDL Barcode textbox to 
set the cursor focus to the textbox. 
Using a 2D barcode scanner, scan the 
barcode on the back of a North Carolina 
driver’s license.  
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3. The NCDL Barcode field will 

populate with the information 
scanned from the barcode.  

4. Click ‘OK’ to determine whether 
or not the license is valid and 
populate the data entry fields. 
One of the messages below will 
display with NOT EXPIRED or 
EXPIRED.  

 

 

 

 

 

 

 

License expiration date has not been reached and is valid.  

    

 

 

 

License expiration date has been reached and is no longer 
valid. 

 

License is still considered valid as it meets the 70 year old exception or the 4-year exception.  

• If the license expired after the voter’s 70th birthday, it meets the 70-year old exception 
• If the license has been expired for 4 years or less, it meets the 4-year exception  
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1. To Search for a voter from an NCDL click 
the Barcode Search icon on the main 
screen. The pop-up to the right displays. 

2. Click in the NCDL Barcode textbox to set 
the cursor focus to the textbox. Using a 
2D barcode scanner, scan the barcode on 
the back of a North Carolina driver’s 
license. 

3. The NCDL Barcode field will populate 
with the information scanned from the 
barcode.  

4. Click ‘OK’ to search for the voter. If a 
match is found, the record will display in 
the Potential Voters grid.   
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CHAPTER 4: NEW REGISTRATIONS AND REGISTRATION UPDATES 

SECTION 1: OVERVIEW 

During one-stop voting, a registered voter may update their name, address, or phone number information so 
long as the residential address change is within the same county.  Due to a preliminary injunction granted for 
House Bill 589, a citizen living within the county can also newly register at a one-stop site and vote during the 
one-stop voting period. Furthermore, a registered voter can also update any of their registered information 
during this same time period except for party if the election is a primary. 

The Update Voter function of SOSA allows the user to update a voter’s registration information using the 
‘Update Voter Reg’ button.  Only active and inactive voters can be updated through SOSA.  One of these 
processes must be performed on INACTIVE voters in order to allow access to voting in SOSA. 

The New Voter function of SOSA allows the user to provide for in-person registration and voting at one-stop 
voting sites using the ‘New Voter Reg’ button.  This is a three-step process which includes Data Entry, Review 
of Data Entry, and Vote. 

SOSA also provides the user a read-only view of a voter’s registration information. 

SECTION 2: UPDATING AN EXISTING REGISTRATION 

To begin the process of updating voter registration information in SOSA Voting use the ‘Update Voter Reg’ 
button on the Home ribbon.  The ‘Update Voter Reg’ button functionality allows updating of the voter’s name, 
residential address, mailing address and phone number.  The intent is that the voter is providing a filled out 
voter application that will be scanned in back at the office.  Also, a name/address change form will print that 
the voter must review and sign. 

The following procedure demonstrates how to update a voter’s registration information, for Active and 
Inactive voters. 

1. Using the Search function, find 
the voter that wants to update 
their information. 

2. Select the voter’s record in the 
Potential Voters grid to 
highlight it. 

3. Click the ‘Update Voter Reg’ 
button on the Home ribbon.   

The Update Voter Registration 
screen will display, as shown 
to the right, with Step 1.  

Use this screen to make any 
registration changes allowed.   

To check the status of a NC 
Driver’s License and/or 
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populate the voter data, click the small barcode icon to the right of the US Citizen checkbox and scan 
the NCDL with a 2D scanner to determine if the ID is expired or not expired. The Data Entry fields will 
be populated with the voter data if the NCDL is found. See Section 10 for more information on 
scanning NCDLs.  

If the voter needs to vote Provisionally, the ‘Vote Provisional’ button will exit the Update Voter 
process and launch the Provisional Data Entry process. See Chapter 3, Section 7 for details on the 
provisional voting process in SOSA.  

If the voter has an issue that requires sending him to the Help Desk, click the ‘Print Referral’ button to 
print a Help Referral Form which the voter will take with them to the Help Desk.  

The ‘Absentee History’ button will display any Absentee information for the current election.  The 
‘View Street Ranges’ button will show the Geocode information for the ‘Street Name’ entered.  Use the 
‘Comments’ button if there is a need to add a comment regarding the registration changes being made. 
‘Cancel Vote’ will cancel the vote process and return you to the search screen.  To clear the existing 
Residence or Mailing address information, click the red eraser icons at the end of each address 
section. 

If the voter has a religious objection to being photographed and has informed the county BOE of this, 
the Religious Objector box will display with a checkmark to inform the One-Stop Worker that photo ID 
will not be provided by the voter. Note: Religious Objector functionality remains, but the ID law has 
been repealed, making this now irrelevant. 

Ask the voter when they moved.  If the voter has moved less than 30 days before the election, select 
the ‘No’ radio button under “Will you have lived here for 30 Days or more prior to the Election Date?” 
and fill in ‘Move Date’.  If they moved more than 30 days before the election, select the ‘Yes’ radio 
button under “Will you have lived here for 30 Days or more prior to the Election Date?” 

If the ‘Move Date’ is less than 30 days before the election, a message will display that the address 
changes will not be saved. If ‘Yes’ is clicked, the registrant can vote at their old address and the 
changed ‘Residence Address’ will revert back to the address on file. If ‘No’ is clicked, it returns to the 
changes screen where you can modify the data or cancel out of the change process.  

Enter all available registration information. 

4. Click the ‘Review’ 
button to complete 
Step 1 and move to 
Step 2.  At this 
point, SOSA will 
determine if the 
voter must provide 
HAVA ID and/or 
select a party ballot 
(similar to Step 7 of 
Chapter 3, Section 
2).  Once this is 
determined and 
provided, if 
necessary, the One-
Stop Application 
form/label will 
print.  If EPB: 
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PRINT NAME/ADDRESS CHANGE FORM is set to ‘Y’ the One-Stop Name/Address Change form will 
also print. Once printed, the voter should be directed to review the information on the form(s) and 
sign, and the user should follow the county procedures in regards to the documentation. 

The “Printing One-Stop Forms” window will display indicating the application form is being sent to 
the default printer. The screen will change to Step 2, as shown to the right, with all fields changing to 
read-only, allowing the user to review the information.  There are several pop-up screens that may 
appear at this stage as well.  They are listed below. 

 

• If an error pop-up screen appears, 
as shown to the right, then the 
residential address entered is 
invalid due to it not being a valid 
Geocode address for the county.  
The user can either fix the address 
(if a mistake was made during data entry) or have the voter vote a Provisional ballot (follow the 
county procedures).  

• If a residential address is valid but 
there is not a valid ballot style 
related to that address (and voter’s 
age) for the election, the user will 
receive the message shown to the 
right.  The user can either fix the 
address (if a mistake was made during data entry) or have the voter vote a Provisional ballot 
(follow the county procedures).  

• If the election is a Primary election 
and the registrant being updated has 
a ballot party with no valid ballot 
style associated with it, the user will 
receive the message shown to the 
right. The voter may have to vote a 
Provisional ballot (follow the county procedures).  

Verify that all changes made are correct and that additional changes are not needed.  If further 
changes are needed, click the ‘Back’ button to go back to Step 1 above. 

5. Click the ‘Vote’ button in order to cast a ballot related to the changes just made.   

NOTE: Clicking the ‘Issue’ button drop-down will give the option to Vote In-Person or Vote Curbside 
(if ‘Allow Curbside Voting’ is checked in the options). Clicking ‘Issue’ without using the drop-down will 
use the ‘Default Voting Method’ that was set in the options.  

Once the Vote process is complete, there is no way to undo the registration change.  If the voter does 
not wish to vote at this time or the user has made a mistake, click the ‘Cancel Vote’ button. 

Once the Vote occurs, the record will be sent to VoterScan for verification of the changes upon 
either the next transfer (or the next processed vote record in connected mode). 

6. If the SOSA option “Create BOD file with vote cast” is enabled, an XML file will be created in 
C:\tmp\BOD with the vote information.   
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SECTION 3: NEW IN-PERSON (SAME DAY) REGISTRATION 

If a voter cannot be found in SOSA using the Search function and/or the voter says they are not registered in 
the county, a new In-Person Registration (IPR) may need to be processed.  This process should NOT be used if 
the voter is already registered, especially during a primary.  It is not intended as an end-around for changing a 
voter’s party, as that change will be caught back at the county office. 

The following procedure demonstrates how to add a new registration. 

1. Click the ‘New Voter Reg’ button from the ribbon.   
Step 1 of the New Registration 
screen will appear, as shown to 
the right. 

Enter all of the voter’s 
information provided (the 
required fields are the 
minimum fields that need 
entry), or click the Barcode 
icon to scan an NCDL barcode 
and populate the data entry 
fields.  The following fields are 
required: ‘US Citizen’, ‘Last 
Name’, ‘Birth Date’, ‘House #’, 
‘Street Name’, ‘City’, ‘State’, 
‘Zip’, ‘30-day move’ radio 
button, and ‘Party’.  To save 
keystrokes during data entry, 
use the ‘View Street Ranges’ button to display the street information.  Double-clicking a row will 
populate all address fields except for the house number.  Enter all available registration information. 

Use the ‘Comments’ button if there is a need to add a comment regarding the new registration.  Click 
‘Print Referral’ to print a Help Referral form if the voter needs to be sent to the help table for some 
sort of problem. Click ‘Vote Provisional’ if the voter needs to vote a Provisional ballot.  

Click the ‘Review’ button to complete Step 1 and move to Step 2.  Select a ‘Proof of Residence’ HAVA 
document from the pop-up list and select a ‘Voting Method’ from the second pop-up list, as shown 
below.  
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2. The screen will change to Step 2, 
as shown to the right, with all 
fields changing to read-only, 
allowing the user to review the 
information. At this point the NC 
Voter Registration Application 
will print if no problem occurred 
with the registration data.  There 
are several pop-up screens that 
may appear at this stage as well.  
They are listed below. 
 
 
 
 

 

 

• If an error pop-up screen appears, as shown to 
the right, then the residential address entered is 
invalid due to it not being a valid Geocoded 
address for the county.  The user can either fix the 
address (if a mistake was made during data entry) 
or have the voter vote a Provisional ballot (follow 
the county procedures). 

• If a residential address is valid but 
there is not a valid ballot style related 
to that address (and voter’s age) for 
the election, the user will receive the 
message shown to the right.  The user 
can either fix the address (if a 
mistake was made during data entry) 
or have the voter vote a Provisional 
ballot (follow the county procedures).  

• If the election is a Primary election 
and the registrant being updated has 
a ballot party with no valid ballot 
style associated with it, the user will 
receive the message shown to the 
right.  The voter may have to vote a 
Provisional ballot (follow the county 
procedures). 

 

Verify that all registration information is correct and that additional changes are not needed.  If 
further changes are needed, click the ‘Back’ button to go back to Step 1. 
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3. Click the ‘Vote’ button in 
order to cast a ballot 
related to the new 
registration. The One Stop 
Application/label will 
print.  Once printed, the 
voter should be directed to 
review the information on 
the form and sign it, 
following county 
procedures.  

Once ‘Vote’ is clicked, there 
is no way to undo the new 
registration.  If the voter 
does not wish to vote at 
this time or the user has 
made a mistake, click the 
‘Cancel Vote’ button.  

 

Once the Vote occurs, the record will be sent to VoterScan for verification of the changes upon either 
the next transfer (or the next processed vote record in County mode). 
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SECTION 4: VIEW REGISTRATION AND PROVISIONAL INFORMATION 

To view more detailed registration 
information for a selected One-Stop 
voter, such as Status, Status Reason, 
Jurisdictions, or DL/SSN, use the 
‘View Voter Reg’ button on the 
Home ribbon in the Registration 
section. The View Registration 
window will appear.  

If voter needs to be sent to the Help 
Desk, click the ‘Print Referral’ 
button to print the Help Referral 
form.  

 

 

 

 

 

To view the information for a 
selected Provisional voter, use the 
‘View Prov’ button on the Home 
ribbon in the Provisional Voting 
section.  
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CHAPTER 5: DATA TRANSFERS 

SECTION 1: OVERVIEW 

Data transfers are required if SOSA is running in LOCAL mode.  The data (registration updates, votes, 
provisionals and returned absentee ballots) on the local machine needs to be sent back to the county server 
and vice versa.  This keeps the voter registration list updated on the local machine as well as updating the 
registration changes, voting, provisionals and returned ballots processed on the local machine in the county; 
this in turn allows other machines to get these details.  The data needs to be transferred on a timely basis. 
There are two transfer types, File and Electronic.  

SECTION 2: LOCAL MODE TRANSFERS-WITHOUT NETWORK CONNECTION 

This function was formerly known as a Disconnected transfer. In LOCAL mode, the transfer of data between 
the local machine and the county server is a manual process involving the transfer of data files.  It is 
recommended that the transfer is completed on a daily basis.  New data export files should be created at the 
county office and sent to every site each morning so all SOSA machines can be updated.  This process updates 
the local SOSA machine with any registration changes or voting performed in other locations or on other 
machines.  At the end of the day, a new data export file should be created on each local machine, transported 
to the office and imported into the county database server using One-Stop System Manager.  This cycle 
repeats each day within the one-stop voting period. 

TRANSFER DATA FROM THE COUNTY BOE 

Below are the steps to transfer data from the file, exported at the county, to the SOSA machine.  The user will 
take the export file located on the portable media device, such as a USB drive, back out to the one-stop site 
and import it into the machine using the steps below. 

1. From the Tools tab in SOSA in LOCAL mode, select the 
‘Transfer’ button from the ribbon and choose ‘File’.  

2. The Data Transfer screen will appear, as shown to the 
right.  Click ‘Browse’ to select the location of the portable 
media device, if needed.  Once the database file location 
is selected, click the ‘Run’ button to start the import of 
the export file. 

3. The screen below will display, indicating that the import 
process has begun.  
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4. Upon completion, a Load Database screen will appear, as shown to the right, 
indicating the import is complete.  The portable media device can now be 
removed and used on a different machine if needed. 

 

 

TRANSFER DATA TO THE COUNTY BOE 

Below are the steps to transfer data from the local machine to the county database server.  A portable media 
device, such as a USB drive, will need to be connected to the machine. 

1. From the Tools tab in SOSA in LOCAL mode, select the 
‘Transfer’ button from the ribbon and choose ‘File’. 

2. The Data Transfer screen will appear, as shown to the 
right.  The default transfer method is ‘From BOE’.  
Change the transfer method to ‘To BOE (New)’.  This 
will create a new transfer file containing all the 
registration changes and/or votes that have not been 
transferred yet.  Click the ‘Browse’ button to select the 
location of the portable media device, if needed.  Once 
the location is selected, click the ‘Run’ button to start 
the creation of the export file.  If the user needs to 
retransfer a previously created transfer file, select ‘To 
BOE (Re-Transfer)’ as the transfer method instead.  
Then the user must select the export date of the file to retransfer. 

3. If the location selected in Step 2 does not exist, the 
screen listed to the right will appear.  The message 
indicates the location does not exist.  Clicking the 
‘OK’ button returns the user to the Data Transfer 
screen which allows the user to select a valid 
location.  

4. If the location selected in Step 2 does exist, once the transfer completes, the ‘Status’ section of the Data 
Transfer screen will populate with updated information.  A sample screen section is shown to the 
right.  If the ‘Status’ shows ‘Transfer Successful’, 
then the file has been created, a Transfer to BOE 
Statistics summary report will be printed, and the 
user can click ‘Close’ to exit the transfer screen.  If 
the ‘Status’ shows ‘Transfer Unsuccessful’, the user may attempt a retransfer or contact the SBE 
Helpdesk. 

The last transfer status can be checked by clicking the ‘Status’ button on the Tools ribbon. 

5. Once the ‘Status’ shows ‘Complete’, the user should take the portable media device and the Transfer to 
BOE Statistics summary report back to the county board of elections office to be imported. 
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SECTION 3: LOCAL MODE TRANSFERS-WITH NETWORK CONNECTION 

This function was formerly known as a Hybrid transfer. In LOCAL mode, the transfer of data between the local 
machine and the county server is either an automated process or a manual process involving the user 
initiating a transfer.  These transfers update the local machine with any changes to the SOSA tables on the 
county database server (registration list, absentee list, and any lookup table changes) and update the county 
data with registration changes or voting performed on the local machines. In order for LOCAL mode to 
perform electronic transfers properly, the SEIMS user password and the SOSA wizard password must 
be EXACTLY the same. If these passwords don’t match exactly, a login error will be received when logging 
into Local mode and the machine will function as a Local machine without network connection. Electronic 
transfers will occur automatically as long as there is a connection back to the county server and the transfer 
interval is not set to Manual.  

Use the following steps to start the manual transfer process.  This will first send data to and then retrieve data 
from the county database server.  This process is only necessary if a transfer of data is needed outside the 
normal LOCAL transfer interval that has been set. 

1. From the Tools tab in SOSA in LOCAL mode, select the ‘Transfer’ button from the ribbon and choose 
‘Electronic’. 

2. The following pop-up screen, shown below, will appear to indicate that the transfer process has 
started.  

 

SECTION 4: CHECK TRANSFER STATUS 

To determine the last transfer status from either an automatic or manual transfer, the user can click the 
‘Status’ button from the Tools tab ribbon.  This will bring up the Data Transfer Status screen, as shown below. 

 

The following statuses are possible: 

• COMPLETE – The transfer finished successfully. 
• INCOMPLETE – The transfer had a problem transferring and was unable to complete. 
• PROCESSING – The transfer is currently in progress. 
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• EXCEED THRESHOLD – The number of records to transfer exceeds the transfer limit. 

SECTION 5: POST ELECTION AUDIT 

The One-Stop Post-Election Audit is a process that the user should run at the end of the one-stop election 
period on each SOSA machine that was installed through the ‘Complete’ method.  This audit process exports 
all the one-stop data (registrations, votes, etc.) made on the local machine and creates an audit data file (in 
xml format).  This data file is imported into One-Stop System Manager where the data in the file is compared 
with the data on the county database (that was transferred over the one-stop period).  The user can view, 
exclude, and process any records that exist in the data file that do not exist on the county.  All SOSA machines 
MUST run the post-election audit in order to convert SOSA to OVRD. 
 

The post-election audit process ensures that all of the one-stop data from the SOSA machines is 
accounted for in the county database server and that a transfer was not accidentally missed. 

 

Important! 
An audit transfer is done at the END of one-stop.  Once it is done, no other one-stop activity can be 
performed on that machine other than searching and re-transferring the audit file again.  View Voter 
will also be available but keep in mind that any one-stop records still awaiting update in VoterScan 
will not display the updated information on the SOSA machine. 

 

EXPORT FROM SOSA 

To begin the post-election audit process, the user must be using SOSA in LOCAL mode.  

1. Click the Tools tab ribbon and select the Post 
Election Audit button from the ribbon. 

2. The Data Transfer – Post Election Audit screen 
shown to the right will display.   Verify the 
location in which to save the audit file; click 
‘Browse’ to bring up the browse folder screen to 
change the location.  When ready, the user 
should click ‘Run’ to perform the post-election 
audit. 

3. Once the audit process is complete, the ‘Status’ 
section will populate, similar to the screen shown 
below.  Also, the SOSA Voting Information screen 
will now indicate that the post-election audit has 
been run, as shown in the screen below and to 
the right. 
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4. Verify there is an audit file as specified in the ‘File Name’ field. 
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CHAPTER 6: REPORTS 

SECTION 1: OVERVIEW 

This chapter discusses the four reports available within the SOSA application.  

SECTION 2: ONE-STOP VOTING REPORTS 

In SOSA, there are five reports that produce either statistics or detail for all activity that has occurred on a 
particular machine: the SOSA Transaction Statistics report, the SOSA Voter Detail report, the Returned By-
Mail Ballot List, the SOSA Provisional Poll Book and the SOSA Transaction Audit List. To access these reports 
in SOSA, select the Tools tab and select SOSA Transaction Statistics, SOSA Voter Detail, Returned By-Mail Ballot 
List, SOSA Provisional Poll Book or SOSA Transaction Audit List from the Reports box.  

 

SOSA TRANSACTION STATISTICS REPORT 

The SOSA Transaction Statistics report gives a summary count of the following information with site and 
machine: votes cast, cancelled votes, notes, provisionals, new 
registrations and updated registrations.   After selecting the menu item, 
the initial screen that displays is a criteria screen for the report, as 
displayed to the right.  

The user selects the machine and election site for which to get statistics.  
The transaction date defaults to all dates, but the user has the option to 
choose only the current day’s counts (select ‘Today’) or a range of dates.  
The user can also select how the report is grouped.  This report will 
only return data for dates within the one-stop period. 
 

The connection mode determines the machine and site list.  In 
COUNTY mode, all the machines/sites related to COUNTY mode 
machines are shown.  In LOCAL mode, only the single local 
machine is available. 

After criteria fields have been chosen, the user clicks ‘View’ to run and 
display the report.  A sample of the report can be seen on the following 
page. 
 

To print the report to the default printer, click the small printer icon (2nd 
from the left).  
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SOSA VOTER DETAIL REPORT 

The SOSA Voter Detail report gives a list of voters with some of their 
registration/vote data.  The data includes name, VRN, residential 
address, vote type, ballot number, party, party voted, vote date, age, 
gender, race, site, and machine.  After selecting the menu item, the 
initial screen that displays is a criteria screen for the report, as 
displayed to the right.  

The user selects the machine and election site for which to get 
statistics.  The transaction date defaults to all dates, but the user has 
the option to choose only the current day’s counts (select ‘Today’) or 
choose a range of dates.  Since this report only is related to an election, 
make sure the dates are valid for the one-stop period. 
 

The connection mode determines the machine and site list.  In 
COUNTY mode, all the machines/sites related to COUNTY mode 
machines are shown.  In LOCAL mode, only the single local 
machine is available. 

After criteria fields have been chosen, the user clicks ‘View’ to run and display the report.  A sample of the 
report can be seen on the following page. 

To print the report to the default printer, click the small printer icon (2nd 
from the left).  
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RETURNED BY-MAIL BALLOT LIST REPORT 

The Returned By-Mail Ballot List report gives a list of voter details for 
voters that have returned a mailed ballot on the SOSA machine.  The 
data includes name, VRN, delivery name, relationship to voter, 
application number, return date, election site, machine and update 
operator.  After selecting the menu item, the initial screen that displays 
is a criteria screen for the report, as displayed to the right.  

The user selects the date(s) for which to get statistics.  The transaction 
date defaults to all dates, but the user has the option to choose only the 
current day’s counts (select ‘Today’) or choose a range of dates.  Since 
this report only is related to an election, make sure the dates are valid 
for the one-stop period. 
 

The connection mode determines the machine and site list.  In 
COUNTY mode, all the machines/sites related to COUNTY mode machines are shown.  In LOCAL mode, 
only the single local machine is available. 

After criteria fields have been chosen, the user clicks ‘View’ to run and display the report.  A sample of the 
report can be seen below. 

To print the report to the default printer, click the small printer icon (2nd 
from the left).  
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PROVISIONAL POLL BOOK 

The SOSA Provisional Poll Book report is a detailed listing of the provisional voting information logged on a 
particular machine. The report displays the count, poll book number, voter name and address, ballot style 
issued, voted date and the PIN number for a provisional voter.  

If SOSA is set to use label printing, this report cannot be printed; it must be exported to a PDF and be 
printed outside of SOSA.  

To run the report, select SOSA Provisional Poll Book from the Reports section of the Tools ribbon.  

 

The report will display as shown below. To export the report, click the first icon on the left.  

 

To print the report to the default printer, click the small printer icon (2nd 
from the left).  

 

 

 

SOSA TRANSACTION AUDIT LIST 

The SOSA Transaction Audit List report is based on the transactions in SOSA.  Both transactions that have 
been processed and those that have been cancelled during the voting process shall be listed. The report can 
be run for Absentee records or Provisional records. The report displays the Name, Application Number or Poll 
Book Number, Record Type, Completed Vote Process (Y or N), Process Date and Ballot ID. Note: Records only 
print on this report if the One-Stop Application or Provisional Application have printed and the process was 
then cancelled via the Cancel Vote button.  
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To run the report, select SOSA Transaction Audit List from the Reports section of the Tools ribbon 

 

After selecting the menu item, the initial screen that displays is a criteria screen for the report, as displayed 
below. There are 2 data types the report can be run for: Absentee and Provisional.  

The user selects the Machine, Type, Transaction Date and Sort By options. The transaction date defaults to all 
dates, but the user has the option to choose only the current day’s counts (select ‘Today’) or choose a range of 
dates.  Since this report only is related to an election, make sure the dates are valid for the one-stop period. 
The Sort By options for Absentee records are Application Number or Ballot ID, for Provisional records the 
options are Poll Book Number or Ballot ID.  

    

After criteria fields have been chosen, the user clicks ‘View’ to run and display the report.  A sample of the 
report can be seen below. 

To print the report to the default printer, click the small printer icon (2nd 
from the left).  
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Absentee Audit List Report 

 

 

Provisional Audit List Report 
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CHAPTER 7: TOOLS 

SECTION 1: OVERVIEW 

This chapter discusses several tools available to the user, including the street search, by-mail absentee ballot 
returns, change password, site and machine information, and convert a SOSA machine to Election Day (OVRD) 
mode.  

 

SECTION 2: STREET SEARCH 

The Street Search tool is used to determine the jurisdiction and ballot style information of a selected street.  
This is useful for looking up ballot styles for specific addresses, especially for provisional voting.  Follow the 
steps below to perform a street search. 

1. Select the Tools tab and then click 
‘Street Search’.  The Street Search 
screen will appear, as shown to the 
right. 

2. Select or enter in any criteria field 
that may help find the street; 
typically this is the street name field.  
The criteria fields include: ‘House #’, 
‘Direction’, ‘Street Name’, ‘Type’, 
‘Suffix’, ‘City’, ‘State’, and ‘Zip Code’. 

3. Click the ‘Search’ button.  The results 
will display in the Streets grid 
section of the Street Search screen 
with plus (+) signs next to them.  
When the plus (+) sign is clicked, it 
will expand the results and display 
all of the detailed information, as 
shown to the right.  The detailed 
information for a row shows all of 
the jurisdictions tied to the street, as 
well as ballot style information 
broken out by Party, Age and Ballot 
Style.  If the ‘Expand All’ button is 
clicked, the detailed jurisdiction and 
ballot information for all results in 
the grid will display.  If the ‘Collapse 
All’ button is clicked, the detailed 
information will be hidden.  
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SECTION 3: BY-MAIL ABSENTEE BALLOT RETURNS 

HB 589 makes the delivery of a by-mail absentee ballot to a one-stop site permissible.  SOSA will capture who, 
where and when a by-mail absentee ballot was delivered, along with other pertinent details, in order to track 
chain of custody.  The By-Mail Absentee Ballot returns function allows the user to process an absentee ballot 
that was returned to the One-Stop site. Once a return has been entered, it can be updated or deleted if 
necessary. The data will be transferred to SOSA System Manager along with the votes and registration 
updates.  

To process a by-mail absentee ballot returned to the One-Stop site, complete the following steps: 

1. Enter search criteria to locate the voter returning the ballot and click ‘Search’.  
2. Select the Tools tab.  
3. Click the ‘New Return’ button. The Returned 

By-Mail Ballot Information window displays as 
shown to the right.  

4. Fill in the Delivery Name (the person returning 
the ballot), Relationship to Voter, and the 
Application Number. The application number 
consists of the absentee type (CIV, MIL, OVR) 
and the unique sequence number (e.g., CIV-8). 
The bottom section of the window will 
populate with the Voter Name, VRN, Election 
Site and Machine. The Return Date, Create Date, 
Update Date and Operator Names are 
populated when the return is saved or updated. Click ‘Save’ to mark the voter as returning a by-mail 
ballot. The Returned Ballot icon will appear in the Voter Information Panel.  
 

To Modify an Existing Return: 
 

5. If a mistake was made with the return, it can be 
updated using the ‘Update Return’ button on 
the Tools ribbon. Only the Delivery Name, 
Relationship to Voter and Application Number 
can be updated, as shown to the right. Click 
‘Update Return” to make and save any changes.  
 

To Delete an Existing Return: 
 

6. If the return needs to be deleted entirely, this 
can be done with the ‘Delete Return’ button on 
the Tools ribbon. Click ‘Delete Return’. At the 
Returned By-Mail Ballot Delete Question pop-
up, click ‘Yes’ to delete the record, and remove 
the Return Ballot indicator. To cancel the 
delete, click ‘No’. Once a return record is 
deleted it cannot be recovered.   
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SECTION 4: CHANGE PASSWORD OPTION 

SOSA provides the ability for a user to change their password, should they need it.  If the user does not know 
their password to log in to SOSA, another user with supervisory privileges can change the password for them.  
By default, a user’s password is set during the set-up process of the Wizard in One-Stop System Manager.  It is 
recommended to change the password after the first login to ensure that secure passwords are being used.  
The user must have the Change Password permission to enable the change password functionality. 

In order for LOCAL mode to function properly with a network connection, each user’s SOSA Voting 
password MUST match their SEIMS password (passwords are case sensitive). 

The following steps describe how a user can change their 
password. 

1. Click on File  InformationChange Password.  The 
change password screen appears, as shown to the right. 

2. Enter the new password in the New Password field.  Enter 
the same password into the Confirm New Password.  Click 
the ‘Change Password’ button to put the new password 
into use. 

Please keep in mind that passwords are case sensitive. Be 
sure to use upper and lower case where necessary.  

If the user has supervisory privileges, the login name field 
will have a drop-down list of users that can be reset.  The 
‘Reset Password’ button can be used by supervisors only.  
To change another user’s password, select the ‘Login Name’ from the drop-down and click ‘Reset 
Password’.  This will reset the user’s password to the system default.  

The Change Password function works the same way in COUNTY mode, but it will change the SEIMS 
Application (VoterView, VoterScan, Report Manager, etc) password.  It is therefore recommended that 
password changes not be made in COUNTY mode.  

SECTION 5: SITE INFORMATION 

SOSA provides site information in three ways through the File menu and Tools ribbon.  These items will allow 
the user to find out information about the site to which the machine is currently set, other Election Day voting 
sites within the county, as well as information about the current machine.  To access the ‘Local Site 
Information: <XXX>’ (where XXX is the precinct of the current machine) and ‘Other Election Sites‘ select the  
Tools ribbon and then click’ Local Site’ or ‘Other Site’. To access the local machine information, click File 
InformationMachine Information. 
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LOCAL SITE INFORMATION 

Local Site Information gives the user address and contact detail for 
the one-stop site for the current machine.  Access to this tool is 
from the Tools ribbon (Tools  Local Site) and will display the 
screen shown to the right.  In the sample, the SOSA machine was set 
to site “MSFD”.  

 

 

 

 

 

OTHER SITE INFORMATION 

Other Election Sites gives the user address and contact detail for other one-stop sites within the county.  
Access to this tool is from the Tools ribbon (Tools  Other Site) and 
will display the screen shown to the right.  To view information for 
other sites, simply select the site from the drop-down list.  

 

 

 

 

 

MACHINE INFORMATION 

Machine Information gives the user details about the local 
machine.  Access to this tool is from the File menu (File  
InformationMachine Information) and will display the screen 
shown to the right.  Information that will be displayed includes the 
Election, Site, Machine, Validation Status and Validation Date for 
the SOSA machine.  It also shows the MBSN and GUID of the 
machine as well as any ‘Status’ messages.  There are also 
indicators for “Full Install” mode and if the “Post Election Audit” 
has been completed. 
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SECTION 6: CONVERT TO OVRD 

SOSA has two functions:  one-stop voting and Election Day use.  One-stop voting is the initial function in which 
the application begins; however, it can be converted to Election Day use.  Once switched between functions, 
there is no way to switch back outside of re-installing the application.  When the application is converted to 
Election Day use, it is referred to as the On-Site Voter Registration Database application (OVRD). 

Certain steps need to be followed to convert a SOSA machine that was used to process one-stop activity to a 
viable OVRD machine.  These steps should be followed once the one-stop period is over or the user knows the 
machine will no longer be used for one-stop voting purposes.  

1. Run the Post-Election Audit task (see One-Stop Post-Election Audit). 

2. It is required that a current data transfer is performed (see Transfer Data from the County BOE) 
between the end of the one-stop period and Election Day.  This guarantees the local machine contains 
the latest data before Election Day voting begins.  If this is not done, the user will receive a warning 
message upon login. 

3. Select FileInformationConvert to OVRD 
from the Menu bar.  A verification pop-up 
screen, as shown to the right, will display.  
This allows the user to not continue if they did 
not wish to start this, as once the conversion 
is complete, it cannot be undone.  Click ‘Yes’ to 
continue. 

4. A pop-up screen will display alerting 
the user they must log out and back 
into the application to complete the 
conversion process. 

5. After logging back into SOSA, the user 
will be notified that they must select 
an election site.  The options screen 
will appear.  Set any options that are 
needed (site and alphabet range are 
required before OVRD will be functional). Please see the OVRD User Manual for further information. 

Notice that once conversion is complete, the SOSA screen title has changed to OVRD.  Many of the 
application references have changed to OVRD to reflect Election Day use. 
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DOCUMENT CHANGES LOG  

 

DATE CHANGES MADE 

05/06/2010 Updated OVRD file name (naming convention) and screenshot on page 54. 

09/16/2010 Updated screenshots and edited Options section. 
Added info about “flag as absentee” to chapter 9. 
Added Site Information section to chapter 8. 

02/11/2011 Removed all references to label printing. 
Updated page 42 with information about passwords now being case sensitive. 
Updated page 46 with new screenshots showing the print button for Local and Other Site Information. 

05/26/2011 Added references to label printing back to document. 

10/10/2011 Minor change made to page 50 regarding incomplete applications search (used to be called pending 
applications). 

01/06/2012 Added references for SOSA IPR Confirmation form for new registrations on pages 35-36. 
Updated chapter 2 and chapter 5 with new messages that may be encountered when performing address 
updates. 

01/18/2013 Updated screen shots. 
Added Disclaimer 

10/10/2013 Reformatted to match admin guide template. 
Screenshots and text updated. 

10/18/2013 Overhaul of entire document: screenshots, formatting, and text data was all updated. 
Removed OVRD references and put them in a new OVRD only manual. 

10/22/2013 Further modifications to screenshot positioning, fixed formatting to match sosa admin guide formatting. 

11/04/2013 Final modifications to spelling/grammar/formatting/screenshots 

12/09/2013 Updated documentation and screenshots for changes to SOSA Voting 

1/9/2014 Updated doc update date and added new note icon to icon section 

03/26/2014 Added screenshot of tools ribbon to chapters 6 and 7. Also added to section 6 information on how to print 
reports from SOSA 

10/01/2014 Updated printing screenshots in chapter 6. 

02/06/2015 Provisional voting information added to appropriate sections. Updates to multiple chapters for changes and 
new functionality stemming from the upcoming SOSA release 

04/17/2015 Various typo fixes and other updates/removals 

07/24/2015 Updated screenshots on multiple pages. Fixed references to Transfer items that moved to the Tools tab. 
Added 2D Barcode Scanning section.  

12/17/2015 Changed references to CONNECTED, HYBRID and DISCONNECTED to COUNTY and LOCAL. Also 



- 58 -  SOSA User Guide 

updated corresponding screenshots. 

12/18/2015 pg 9-10: updated screenshot and table to add new button "Print Referral" 

pg 18:  updated ID Documents List and screenshot 

pg 19:  added bullets regarding new buttons-Vote Provisional and Print Referral. 

pg 24-27:  updated provisional screenshots and added sections regarding printing an Acknowledgment of 
Voting Options form (#5) and using the Curbside checkbox and the Reasonable Impediment radio button 
(#8) 

pg 29:  added screenshots for 2 new DL Expired messages 

pg 30-32:  updated screenshots. added info to #3 regarding new buttons-Vote Provisional and Print Referral. 
Added Note regarding Religious Objection flag (checkbox).  

pg 36:  updated transfer status screenshot 

updated screenshots throughout entire document where necessary 

01/13/2016 Multiple updates to screenshots and text based on development suggestions/review. Added section for help 
referral form. 

02/02/2016 Several edits to various pages and added back the Same Day Registration instructions 

04/15/2016 Updated screenshots of ribbon to reflect new icon labels, updated icon label text in document, and added 
new section to the reports for the new transaction audit list report 

07/21/2016 Updated screenshots throughout as necessary. Added information to NCDL barcode scanning regarding 
auto-population of voter data.  

08/25/2016 Updated help referral form screenshot 

08/30/2016 Removed references to Reasonable Impediment 

01/27/2017 Updated pg 7 sosa title bar; updated screenshots pg 51 

06/29/2017 Updated screenshots throughout and some minor edits 
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